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Contribute Introduction

What is Contribute?

CONTRI BUTE 3‘ , Created as a partner to Macromedia Dreamweaver™ (Macromedia’s
comprehensive web development software application) lets everyone in an organization publish
up-to-date content and information to existing websites without needing to learn advanced web
development techniques.

The Contribute Workflow

Contribute uses a browse-edit-publish workflow to help you easily find the page you want to edit,
make changes to the page, and then update the page on your website.

Here’s an overview of the Contribute workflow:

1. Browse to a page. Use the Contribute browser to find the web page you want to edit. The
browser’s behavior, as well as its look and feel, will be familiar to users of Microsoft Internet
Explorer and other popular browsers. The browser toolbar has the normal navigation buttons
plus a Choose button to help you navigate to files that aren’t linked on your website. You can
create bookmarks in Contribute and view your Internet Explorer bookmarks. You can also use
shortcuts to view current drafts quickly.

2. Edit your content. After you browse to the page you want to edit, click the Edit Page button
in the toolbar to open the page in the Contribute editor. Contribute copies the file from your
web server and locks it on the server so that no one else can edit the page while you're
working on it.

The Contribute editor works much as a word processor does. You can edit text, images, tables,
and links on the page, and you can even add Microsoft Word or Excel documents to your
website. The toolbar contains familiar editing buttons, plus buttons for saving your edits until
later, canceling your edits, or publishing your edits to the website.

3. Publish the changes. When you finish editing your page, you are ready to publish the page
to your website. Simply click the Publish button, and Contribute replaces the existing page on
your web server with your edited version so that it is live on your website. Contribute also
unlocks the file on the server so that other users can edit the page if necessary.

Who should use Contribute?
Anyone responsible for maintaining an existing website.
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Connecting to your site

Creating a Webdav Connection (Using the
Connection Wizard)

Before you begin, gather the following information:

1.

Web address (URL) of the website
http://webdav.du.edu/servlet/nexus/dav/agora/htd
ocs/ your folder name

How do you connect? WEBDAV
http://webdav.du.edu/servlet/nexus/dav/agora/htd
ocs/ your folder name

Web server login and password (login=DU e-mail
ID)

Username (your DU ID, NOT your full name)
Your e-mail address

To create a new website connection:

1.
2.

3.

Start Contribute.

From the Edit menu select my
connections.

The My Connections dialog box
appears. The options in this dialog
box let you create and manage your
Contribute connections.

Click Create. The Connection Wizard
(Windows) or appears to guide you
through setting up a new website
connection. As you complete each
screen in the wizard or assistant, click
Next to go to the next screen.

Select Administrator as your role.

On the Summary screen, review the
connection settings to verify that
they’re correct and click Done
(Windows) or Finish (Macintosh) to
complete the connection. Contribute
creates a connection to the website.

After Contribute has successfully created
a connection to the website, the
Connection Wizard closes, and the main
page of the website appears in the
Contribute browser.

Accessing web pages for editing

View web pages
Contribute allows you to browse toa 1.

To access a web page in Contribute:
Launch Contribute.

page as you would in any web 2. Under the Begin editing my websites heading, choose

browser.

the site you wish to edit. The homepage for that site will

appear in a browser-type window within Contribute.

.
3. Click the Connect toolbar button.

4. Navigate to the desired page.
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Editing pages

Enter Edit Mode To edit a page on your website:
You can edit pages on websites that 1. Browse to the page you want to edit.

you’re connected to and have [QE iit Page
permission to edit. You cannot edit 2. Click the Edit Page lbutton in the toolbar.

a page if the page is locked--that is,
if someone else is currently editing
it. When you browse to a page, the
message area under the toolbar
indicates whether you can edit that
page.

While you edit a page, Contribute
saves it as a draft, and the draft
title appears in the Pages panel in

the sidebar.
Insert or edit text Contribute works like a word processor to add and edit text.
Type and edit text as you would in any word processor.
Insert images To insert an image into a web page:
1. While in the edit mode, click the Insert Image button
ﬁ_ Image
2. Locate and select the image on your computer or on the
web.
3. Click Select.
About Links

You can make text or images in your web page act as links. When a visitor to your website clicks a
link--specified text or an image--the browser takes the visitor to another web page or file, or starts
their e-mail application.

Your text or image can link to any of the following:
e A current draft or a recently published page on your website
e A new web page, which Contribute creates at the same time as the link
e An existing web page on your website or on another website
e An e-mail address
¢ An existing file on your computer, such as a Microsoft Word or PDF file
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Create a link to a page on your 1. In your page, select the text or image that will navigate to
website or on another website the link.
2. From the Insert Link dialog box, enter the web address of
the page you wish to link to.
3. Click OK.
Create a link to a new page To create a link to a new page:
You can create a link to a new 1. Select the text or image that will navigate to the link.
web page on your website--that &5 _ Link
page that Contribute creates at select Create New Page.
the same time that it creates the 3. Choose either New Blank Page or Template.
link. 4. Click OK. Contribute adds the link to the page, and then
opens the new page in the Contribute editor.
To return to the draft where you added the link, click the
draft title in the Pages panel.
Create a link to an e-mail To create a link to an e-mail address:
address 1. Select the text or image that will navigate to the link.
You can create a link to an e-mail &5 Link
clicks the link, Contribute creates select E-mail Address.
a new message, with the e-mail 3. Enter the desired e-mail address
address you specified, in the 4. Click OK.
visitor’s default e-mail application.
Create a link to a file on your To create a link to a file on your computer:
computer 1. Select the text or image that will navigate to the link.
To add content that you have &5 Link
website, create a link on a page select File on My Computer.
on your website to a file saved on 3. Browse to locate the desired file name.
your computer or network. When 4 click OK.

you publish the page with the link,
Contribute copies the file into
your website and then links to
that copy--not to the actual file on
your computer.

Contribute copies the file to create a new page on your
website. A link to the new page appears in your draft.
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Previewing a page in your
default browser

When you edit a page Contribute
you must ensure that your
changes appear as you intend in
the browser. Previewing your
page also gives you an
opportunity to test your links
before you publish the page.

To preview a page in your browser:
1. Press the F12 key.

Note: If the Contribute administrator assigned you to a role
that cannot publish, you cannot use the Preview in Browser
feature.

Saving drafts

Contribute automatically saves a
copy of your draft when you
switch to the browser, switch to
another draft, publish the draft, or
exit Contribute; but you can also
periodically save your work if

you want.

When you edit a page, Contribute
automatically saves the page as a
draft, and the draft title appears

in the Pages panel in the sidebar.

To save a draft until later:

1. Click the Save for Later button in the toolbar to close the
draft and switch to the browser.

To open a saved draft:

1. Click the draft title in the Pages panel to return to the draft
you were previously editing. The draft appears in the
Contribute editor for you to continue editing.

NOTE: It is not recommended that you save a draft for later if
several individuals are maintaining the same site. If a draftis
saved for later no one else will be able to edit the page until
you have published it. They will receive the following message
and the Edit Page button will be unavailable on their toolbar:

@ ‘ou can't edit this page now because JDerksen (jderksen@du, edu) is currently editing it.
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Rollbacks To roll back to a previous version of a page:
Rollback pages are backup 1. Browse to the page that you want to roll back.
versions of each web page 2. From the File menu, choose Actions, then Roll
published with Contribute. Enable Back to Previous Version.

Rollback is on by default. You can
disable rollback or change the
number of rollback versions. Each
rollback page is a copy of the last
published version of that page

3. Select a previous version of the published page from
the list of available pages.

Note: The list of previously published pages shows a
number of previous versions of the page, depending on

before the currently published your Contribute administrator’s setting.

version. Contribute displays the page in the Preview section.
Contribute can maintain as many 4. If the page you selected is the one you want to publish,
as 99 rollback versions of each click the Roll Back button. If the page is not the one
published page. When you specify you want to publish, select another page from the list,
the number of rollback pages, and then click Roll Back.

carefully consider the amount of Contribute replaces the currently published version of
disk space that will be consumed the page with the previously published version that you
by storing the rollback pages. The selected. The version you selected becomes the current
pages are stored on the web version on the website.

server. The default number of

rollback pages is three. Note: The page you replace with the selected rollback

page appears in the Roll Back Page dialog box the next
time you open the dialog box so you can roll back to
that version if you need to.

Publishing Updated Pages

Publishing updates to an To publish updates to an existing page:
existing page 1. After editing your page, click the Publish button
When you publish updates to an Z1) Publish

existing page, Contribute replaces : on the toolbar.

the currently published version of If the draft contains links to any new pages, the Publish New
the page on your website with the Linked Pages dialog box appears.

new version. If the Publish New Linked Pages dialog box appears, for each
When Contribute publishes your unpublished linked page, click the page name to select it,
draft, it also publishes any new change the filename and folder location if you want, and then

pages that your draft links to (but click Publish All.

not pages that link to your draft).  Note: Depending on the role the Contribute administrator

Contribute prompts you to name  gsigned you, you might not be able to publish.
any linked pages that haven’t

been published before. Publishing
all new pages that are linked from
the draft helps ensure that you do
not have broken links in your
website.
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The Possibilities

Creating New Pages

You can create a blank web page
to add to your website.
Remember to add a link to the
page before you publish;
otherwise, website visitors
cannot navigate to the page.

To create a blank web page:

1.

2.

3.

In the Contribute browser, click the New Page button to
open the New Page dialog box.

In the Create new page for section, expand the website in
which you want to create the new page, if it is not already
expanded.

In the Create new page for section, select Blank Web
Page.

Note: If you don’t see this option, then your Contribute
administrator has restricted the types of new pages that you
can create. For more information, talk to your Contribute
administrator.

4.

Enter a page title in the Page title text box. (This title
appears in the browser title bar when a website visitor views
the page; it does not appear on the page itself.) and Click
OK.

The new page opens as a draft in Contribute.

Copying a page on your
website

You can create a copy of the
page you are currently viewing
on your website. You must be
viewing the page in the
Contribute browser. You cannot
create a copy of a page that is a
draft in the Contribute editor.
Also, you cannot copy a page
from one website to another
website.

To create a copy of a web page:

1.

2.

5.

Browse to the page you want to copy

. [y Mew Page
Click the New Page button on the toolbar.

(Note: If you cannot select this option, contact your
Contribute administrator, who has restricted the types of
new pages that you can create. )

In the Create new page for section, select Copy of
Current Page. A preview of the page appears in the
Preview pane on the right side of the dialog box.

Enter a page title in the Page title text box. This title
appears in the browser title bar when a website visitor views
the page; it does not appear on the page itself.

Click OK. The new page opens as a draft in Contribute.

NOTE: Be sure to add a link to your new page before you
publish it.
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Creating a page based on a
template

You can create a new page
based on a template, which can
help you maintain a consistent
look across your website.

To create a new page based on a template:
1. In the Contribute browser, click the New Page

|_“] Mew Page .
button in the toolbar.
2. In the Create new page for section, expand the website in
which you want to create the new page, if it is not already
expanded.

3. In the Create new page for section, expand the
Templates folder, and then select a template. A preview of
the page you select appears in the Preview pane on the
right side of the dialog box.

4. Enter a page title in the Page title text box. This title
appears in the browser title bar when a website visitor views
the page; it does not appear on the page itself.

5. Click OK.

The new page opens as a draft in Contribute. Be sure to add a
link to your new page before you publish it.

Adding Word or Excel content
to a page

You can add the contents of a
Word or Excel document to a
new or existing web page.

When you add content to a
page, Contribute converts it to
HTML and copies it to your web
page. You can then edit the
content in Contribute; changes
you make to the original file on
your computer do not appear on
your website.

To add the contents of a Word or Excel document to a

web page:

1. In your draft, place the insertion point where you want the
content to appear.

2. From the Insert menu, choose Microsoft Office
Document.

3. In the Open dialog box, browse to the file you want to add,
and then click Open.

4. In the Insert Microsoft Office Document dialog box, click
Insert the contents of the document into this page,
and then click OK.

5. The contents of the Word or Excel document appear in your
page.

Adding keywords and a
description for a page

You can associate keywords and
a description with your web
page. Visitors who type one of
your keywords in a search
engine can find your page.

To add or change keywords and a description for a page:

1. Browse to the page you want to add keywords and a
description for, and then click the Edit Page button in the
toolbar. A draft opens in the Contribute editor.

2. Select Format > Keywords and Description. The Page
Keywords and Description dialog box appears.

3. Enter or change keywords in the Keywords pane. Separate
each keyword with a single space (for example, meeting
minutes planning committee holiday party).

4. Enter or change the page description in the Description
pane.

5. Click OK.
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Understanding the draft review process

The Contribute draft review process enables you to send a draft to other Contribute users to get
feedback or to collaborate before you publish the draft. Or, if your role doesn’t allow you to publish
directly to the website, you might need to send the draft to someone who can review the draft and
publish it.

You can send a draft for review to anyone who has connected to the website; Contribute stores
user names when users connect to the website. You can send the draft to multiple reviewers at one
time, but only one person can edit the draft at a time. When you send a draft for review, you
transfer "ownership"” of that draft to the reviewer. That means the reviewer has to take action on
the draft. After you send a draft for review, you can track the draft to see what action the reviewer
takes on the draft.

When you receive a draft for review, it appears in your Pages panel in Contribute. You might also
receive an e-mail message from the sender to alert you that you have a draft to review. As a
reviewer, you can decide to edit the draft, send it to another user for review, or discard all changes
by canceling the draft. Depending on your role, you might also be able to publish the draft.

To use the e-mail review 1. While viewing your webpage, click the Send for Review
process button in the toolbar.

2. In the Send for Review dialog box, select the Send e-mail
with a link to a preview of the draft option, and then
click Send.

3. If the Send New Page dialog box appears, you can change
the draft’s filename or click Choose Folder to save this
draft in another location. Then click Send. Contribute
creates a new e-mail message in your default e-mail
application.

4. Enter the reviewer’'s name and a message, and then send
the e-mail message.

Note: The current folder location appears in the web
address (URL) under the filename.

If the Send Linked New Files dialog box appears, select each
unpublished linked page to change the filename and folder
location as necessary. Then click Send All.

In Contribute, you can work on another draft or switch to the
Contribute browser until you receive feedback from the
reviewer. When you receive feedback from the reviewer, click
the draft title in the Pages panel to return to the draft and
update it.

Note: When you cancel or publish the draft, Contribute
removes the temporary copy of the draft that it placed on the
server for the reviewer.
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